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Introduction 
 

It is a strategic priority, moral imperative and legal requirement for 

the British Museum to be accessible and representative to a broad 

range of audiences, supporting equality and diversity in our areas of 

work.  

 

These guidelines identify some key approaches to making online and 

online digital content accessible to a range of audiences across all 

our digital media platforms. 

 

Web Content Accessibility Guidelines (WCAG)i 

The British Museum aims to make our website content and online 

resources accessible to WCAG 2.1 AA standard. These guidelines 

have informed the content of this document.   

 

Social Model of Disability 

The British Museum uses the social model of disability when 

considering the access requirements of our audience:  

“The social model of disability says that disability is caused by the 

way society is organised, rather than by a person’s impairment or 

difference. It looks at ways of removing barriers that restrict life 

choices for disabled people. When barriers are removed, disabled 

people can be independent and equal in society, with choice and 

control over their own lives.” Scopeii 

 

Anyone creating online content should audit their designs to identify 

potential barriers for disabled people, and then develop strategies to 

address them. 

 

The Equality Act 

The Equality Actiii provides a legal framework to ensure that disabled 

people are not treated less favourably because they are disabled. 

The British Museum has a legal duty to anticipate the needs of 

potential disabled visitors and make ‘reasonable adjustments’ to 

ensure that disabled people are not put at a substantial (more than 

minor or trivial) disadvantage.  

 

 

 

 

 

 

 

 



Digital Media 
NB.  The Exhibitions Department and the Interpretation Team have 

separate guidelines for digital media in special exhibitions and 

permanent galleries.  This document does not supersede those or 

cover digital media on-site.  

 

Film 

WCAG 2.1 AA Criteria  

 

1. Captions. Prerecorded Digital Media  
Captionsiv are provided for all pre-recorded audio content, except 

when the media is a media alternative for text and is clearly labelled 

as such. 

 

Captions can be open (always visible) or closed (can be turned off 

and on by the viewer). 

 

On-screen text can also take the form of interpretive captions that 

explain silent or non-narrated films. As a guiding principle, on-screen 

interpretive captions should be kept as short as possible. 

 

2. Captions. Live Synchronised Media 

For webinars and live synchronized media live captions should be 

provided through a Speech to Text Reporter or real time captioning 

service.  

 
Techniques and requirements 

Caption requirements should be agreed at the early planning stages 
for digital media. They should be clearly specified in the brief before 
it is issued to internal stakeholders or external agencies.  

Some digital media may not require on-screen captions, e.g. films 
with minimal ambient audio. In this instance information can be 
provided in the credits to highlight ‘this film is silent’ or provide 
minimal information on the audio  

Guidelines for on-screen text 

1. On-screen long enough to be read: typically, 3 words per second  
2. Limited to no more than two lines, and no more than 16 words (8 

per line), at a time 
3. Presented as white text on a dark background (minimum 70% 

contrast), that extends across the full width of the screen 
4. In a sans-serif font  
5. At a point size that is easily readable, taking into account the size 

of the screen and the point size of adjacent printed graphics  
6. Synchronized and equal in content to spoken words / audio 



7. Not obscured by, and does not obscure, visual content 
8. Centred on screen  
9. Consistent in style and presentation  
10. All dialogue and significant audio elements should be captioned 

e.g. [THUNDER],             [♪ BLUES HARMONICA ♪] 
11. Silent digital media must state that there is no sound, to assure 

Deaf and hard-of-hearing people that they are not missing 
information  

 

Filming requirements 

The bottom 20% of the screen should be left as the caption safe 

zone, with no graphics, and the shot set far enough back that 

subtitles are not blocking lip reading or visual content. Wherever 

possible it is beneficial for Deaf and hard-of-hearing audiences to 

clearly see the person speaking. 

Further information and resources  

For further details on captioning including how to identify multiple 

speakers, different languages and music, follow the links below. 

Digital subtitling best practice guidelines by Stagetext: 

http://www.stagetext.org/uploads/Digital_Subtitling_Best_Practice_-_final.pdf 

 

Subtitle guidelines by BBC: 

http://bbc.github.io/subtitle-guidelines/ 

 

Subtitling online content best practice guidelines by Stagetext: 

http://www.stagetext.org/training 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.stagetext.org/uploads/Digital_Subtitling_Best_Practice_-_final.pdf
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http://www.stagetext.org/training


Audio Descriptionv 

WCAG 2.1 AA Criteria 

 

Audio description is provided for all pre-recorded video content in 
synchronized media. 
 

Techniques and requirements 
 
Embedded Audio Description:  

Where all key visual onscreen content is provided in existing audio, 

no additional audio description is necessary i.e.:  

 

• Speakers identify their name and job title (alongside name 

captions)   

• A visual description of objects / location is given (if integral to 

an understanding of the DM content)   

• Contact information, on screen ‘calls to action’ and credits are 

read out. 

 

Creating a second user selectable Audio Track 

When key information is only provided by offering additional Audio 

Description: 

• Audio Description is either synchronized to the visual content 

in the pauses in dialogue, or over visual only content as 

demonstrated here: 

https://www.youtube.com/watch?v=0I0Bl0B_2zA 

• If required, an ‘extended audio description’ is offered by 

creating pauses in the DM to create more time for Audio 

Description. 

 

Text alternatives 

When it is not possible to record and edit an audio description over 

the film an audio description transcript in text alternative can be 

provided. This sits alongside the film (on the website or DM host site) 

for a blind or partially sighted person to read during, after, or instead 

of the film. This can include contact information, onscreen ‘calls to 

action’ and credits. (This technique meets the WCAG 2.1 A standard) 

 

For talking head films and films that contain no integral visual 

information a short description will suffice i.e.: ‘[interviewee name] 

talks to camera’ 

 

 

 

https://www.youtube.com/watch?v=0I0Bl0B_2zA


Further information and resources  

VocalEyes Guidelines for digital accessibility: film 

https://vocaleyes.co.uk/services/resources/guidelines-for-digital-accessibility-film/ 

 

For more information on how the above meet Web Content 

Accessibility Guidelines:  

https://www.w3.org/WAI/WCAG21/quickref/ 

 

  

https://vocaleyes.co.uk/services/resources/guidelines-for-digital-accessibility-film/
https://www.w3.org/WAI/WCAG21/quickref/


Alternative text for Images and 
Photography (Alt text or Alt Tags) 
 

Alt Text provides a written description of an image, which can be 

read out using screen reader software, making images accessible to 

blind and visually impaired people.  

 

Alt Text is not a caption and in most cases, does not appear 

alongside the image. In HTML this reads as alt="text of image" 

 

Alt Text should be used anywhere you have images online; on the 

website, in downloadable documents and across social media 

accounts. 

 

Techniques and requirements 

• Keep your description short, ideally no longer than ten words 

• Focus on the visual elements of the image. The image or 

photo should be accompanied by a caption (which includes 

title, provenance, materials, date) so there is no need to 

repeat this information 

• Use gender neutral language where possible  

• Don't include "image of," "picture of," etc. in your alt text. This 

will be obvious to the user 

• For Spacer and decorative images, leave the alt attribute 

blank, or empty: alt=””. If you leave out the Alt attribute entirely 

the file name will be read out  

 

NB. Facebook and Instagram posts auto generate Alt Text but you 

may want to review and add clearer descriptions. 

 

The following examples give an overview of some common images 

we might use in our online communications including images of the 

Museum, visitors, objects, logos and graphic images.  

 

 

 
 

alt = "The British Museum Logo" 

 

For The British Museum and other funder logos include the alt text alt 

= “funder name logo”. If the logo has a function, i.e. The British 

Museum logo returning visitors to the home page, this should be 

indicated in the alt text.   



 
 

Example: alt = “Seated visitor reading a comic book at the 

Manga exhibition” 

 

Never assume someone’s identity (for example gender, ethnicity, 

age) and only include if relevant and necessary to the understanding 

of the image. 

 

 
 

Example 1: alt = “Front view of The Rosetta Stone” 

Example 2: alt = “Grey stone slab with ancient scripts etched onto its 

surface” 

 



Alt text should add to information already on-screen. If a caption is 

included alongside an image providing the name of an object, do not 

repeat this information. Instead utilise the space to provide a more 

visually descriptive alt text (see Example 2). 

 

 
 

Example: alt = “Visitors standing in the Great Court, British Museum” 
 

 

 

 
 

Example: art = “Hashed eye symbol” 

 

 

 



 

Graphs and infographics  

These should have an alt attribute such as ‘graph showing increase 

in museum visitor numbers between 2016 and 2019’. Graph data 

should be available in text format as well.  

 

Accessible Word docs, PDFS and 
PowerPoint Presentations 
 

Formatting 

 

• Use Headings and Document Styles to create a navigable 

structure. 

This helps people who are accessing the document via a 

screen reader to identify Titles, Headers and normal text and 

ensures the information is read in a logical order. 

• Alt Tag images. This gives people who are accessing the 

document via screen reader software a brief visual description 

of the image.  

• Ensure tables are clear, consistent and avoid merged / split 

cells. 

• Use meaningful hyperlink text. If you copy and paste the full 

URL into your document, the screen reader will try to read out 

each letter. Creating meaningful links is clearer and more 

concise for people using screen reader software.   

Identify where you want to add a hyperlink, right-click on the 

line where you want the link and select to Hyperlink (or go 

to Insert and then Hyperlink). Copy or type the URL into the 

address or link to text box. 

Include a description under display or text to display. This is 

the writing that will be visible in your document, and when 

clicked it will take the reader to the website of the URL. 

• Check the accessibility! Here are some tips: 

 

Word 

Review > Check Acessibility. This checks the accessibility of 

your document and highlights any issues with images, tables 

and general layout.  

 

Review > Read Aloud. This function enables you to check 

how the document scans when accessed via a screen reader. 

 

Options > Proofing > Show readability statistics. This 

provides information on the reading age of your documents, in 



a pop up after a spelling check is completed. For reference a 

Flesch-Kinard level of 8 is is an average reading age of a 13 

year old.  

 

PDFs  

If a PDF has been made from an Word document which has a clear 

structure, utilises the Headings and Document Styles and has been 

through the accessibility check, it will convert into an accessible PDF.  

 

There are ways to edit the accessibility after it has been converted 

but it is far better to ensure the original source document is 

accessible.  

 

View > Read Out Loud > Activate Read Out Loud. If you are 

accessing a PDF via Adobe Reader you can activate the Read Aloud 

Function. This function enables you to check how the document 

scans when accessed via a screen reader. 

 

Powerpoint 

Review > Check Acessibility. This checks the accessibility of your 

document and highlights any issues with images, tables and general 

layout.  

Slideshow > Captions and Subtitles. When delivering your 

powerpoint you can enable automated captions to appear. NB You 

may need to upgrade your Powerpoint to access this function. 

 

Design  

 

Fonts 

NB.  The Exhibitions Department and the Interpretation Team have 

separate guidelines for temporary Exhibitions and Permanent 

Galleries. The Marketing team have separate guidelines for printed 

materials. This document does not supersede those. 

 

• Aim for 12 point minimum fontsize. BM Large print guides are 

set at 22 point. 

• Choose sans serif fonts and avoid hanswritten fonts 

• There should be generous spacing between lines 

• There should be clear definition between columns of text 

using a margin or line spacing 

• There should be clear hierarchy of information 

• Text should be justified to the left with a ragged edge right 

• Avoid the use of vertical text 

• Avoid text all in capitals 



• Italics  should generally be avaoided except for quotes, to 

distinguish a foreign word or for poems 

• Avoid using colour or images alone to convery meaning 

 

Contrast  

The better the contrast, the more legible the text will be.  

Avoid:  

  Mid-tones 

  Text over an image or patterned background 

 

Reversed out text 

To avoid a ‘halo’ effect, use off-white (cream or grey) instead of white 

text on a black or very dark background. 

  



Language and Terminology Guidelines 
 

It is important we can communicate with respect and confidence 

when discussing Equality and Diversity across the British Museum in 

person, on-line and in print.  

 

General tips 

• Take the lead from the individual or community group and be 
open to adapt the language you use based on their feedback.  
If you make a mistake initially, apologise and move on 

• Some individuals and community groups have re-appropriated 
terminology, which have previously had pejorative 
connotations (for example Crip, Dyke, Queen). It is best to 
avoid these terms unless you are confident and familiar with 
the context  

• Ensure the language you use is respectful, understandable 
and is not emotive 

• Avoid generalisations and use of the definite article when 
discussing people for example ‘the Deaf’ and ‘the elderly’ 

• Never make assumptions about someone’s identity 

• Don’t panic! If you are unsure just ask 

 

Disability  

The Social Model of Disability is a framework that was developed by 

disabled people in the UK in the 1980s and 90s. It states that a 

person is not disabled by an impairment or medical condition but by 

barriers in society. This informs the language we choose for example 

we use the terms ‘disabled’ and ‘non-disabled people’, ‘accessible 

parking’ and ‘accessible toilets’ (rather than disabled toilets / 

parking).  

 

A note on ‘Deaf and disabled’ 

Many Deaf people capitalise the D in deaf because they identify 

culturally as part of the Deaf community. They may not identify as 

disabled.  

 

At the British Museum we recognise this distinction and use the term 

‘Deaf and disabled people’.   

 

LGBTQ 

The BM currently uses the acronym LGBTQ, as a shorthand for 

Lesbian, Gay, Bi-sexual, Transgender and Queer people.  

 

Sometimes this is also represented with LGBTQ+ to include other 

spectrums of sexuality and gender such as questioning and intersex. 

 

 



 

BAME 

Black and Asian Minority Ethnic or BAME is widely used in the UK 

and is typically used in diversity monitoring. It is always best to ask 

the individual or group how they like to be addressed, in a particular 

context. 

 

It is important to know the issues with abbreviations and acronyms: 

• They imply that BME/BAME individuals are a homogeneous 

group 

• It is generally perceived that these terms refer only to non-

white people, which does not consider white minority ethnic 

groups 

• They can be perceived as convenient labels that are placed 

on minority ethnic groups of people, rather than identities with 

which people have chosen to identify. 

 

NB: It is important to recognise the potential differences between 

ethnic origin and national identity.  
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i For more information go to https://www.w3.org/TR/WCAG21/ 
ii For more information about the Social Model – see Scope’s webpage:   
http://www.scope.org.uk/about-us/our-brand/social-model-of-disability 
iii https://www.equalityhumanrights.com/en/equality-act-2010/what-equality-act 
iv Captions are equivalent to the audio and ensure that interpretive content is accessible to a wide 

audience, including those who are deaf or hard-of-hearing. These should be provided whenever 
auditory multimedia content is present.  

v Audio Description provides a narration describing important visual details that cannot be 

understood from the main soundtrack alone, and are predmenantly used by blind and visually 

impaired people.  
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